
TM 82 60 mobile

Installation and
Programming Guide

MMA-00041-02
Issue 02

June 2006



2 TM8260 Installation and Programming Guide
© Tait Electronics Limited June 2006

Contact Information
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Technical Support
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Website: http://support.taitworld.com

Copyright and Trademarks
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Intellectual Property Rights
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To Our European Customers
Tait Electronics Limited is an 
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Preface

Scope of Manual
This manual describes the installation and programming of TM8260 dual 
mobile radio systems. A dual radio system is where one control head is 
connected to two radio bodies.

The installation of accessories is described in the installation instructions 
provided with the equipment, and the relevant section in the service 
manual.

Associated Documentation
TM8260 User’s Guide (MMA-00040-xx)

TM8200 Programming Application Online Help

TM8100/TM8200 Service Manual (MMA-00005-xx)

Technical notes are published from time to time to describe applications for 
Tait products, to provide technical details not included in manuals, and to 
offer solutions for any problems that arise.

All available TM8200 product documentation is provided on the CD 
supplied with the service kit1. Updates may also be published on the Tait 
support website.

Document Conventions
Within this manual, four types of alerts are given to the reader: Warning, 
Caution, Important and Note. The following paragraphs illustrate each type 
of alert and its associated symbol.

Warning!! This alert is used when there is a potential risk of death 
or serious injury.

Caution This alert is used when there is the risk of minor or moderate 
injury to people.

Important This alert is used to warn about the risk of equipment 
damage or malfunction.

Note This alert is used to highlight information that is required to ensure 
procedures are performed correctly.

1. Technical notes are only available in PDF format from the Tait support website. 
Consult your nearest Tait Dealer or regional office for more information.
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Within this manual, the following symbols are used to highlight differences 
between the 40W/50W and the 25W radios:

This symbol highlights information that is relevant to 40W/50W radios.

This symbol highlights information that is relevant to 25W radios.
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Safety Warnings

This section contains important information on the safe installation of the 
radio system. You must read this information before starting the installation.

You must also read and observe the safety information on radio operation 
provided in the user’s guide.

RF Exposure Hazard

To comply with FCC RF exposure limits:

For 40W/50W radio bodies:

■ VHF radios must be installed using an antenna mounted centrally on the 
vehicle roof, with a gain of 2.15dBi or 5.15dBi.

■ UHF radios must be installed using an antenna mounted either centrally 
on the roof with a gain of 2.15dBi or 5.65dBi, or centrally mounted on 
the trunk with a gain of 5.65dBi.

For 25W radios:

■ The radio must be installed using an externally mounted antenna with a 
gain of either 2.15dBi or 5.15dBi.

In all cases, an antenna must not be mounted at a location such that any 
person or persons can come closer than 35 inches (0.9m) to the antenna.

Safe Radio Mounting
Warning!! Mount the radio securely so that it will not break loose 

in the event of a collision. An unsecured radio is 
dangerous to the vehicle occupants.

■ Mount the radios and the microphone where they will not interfere 
with:

■ the deployment of passenger airbags
■ the vehicle operator controls
■ the vehicle operator’s view.

■ Do not mount the radio bodies vertically, with the remote interface 
facing down. This will violate compliance with the standards UL/CSA/
EN 60950, Safety of Information Technology Equipment.
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Interference with Vehicular Electronics
Warning!! Some vehicular electronic devices may be prone to 

malfunction due to the lack of protection from RF 
energy when your radio is transmitting.

Examples of vehicular electronic devices that may be affected by RF 
energy are:

■ electronic fuel injection systems

■ electronic anti-skid braking systems

■ electronic cruise control systems

■ indicators.

If the vehicle contains such equipment, consult the vehicle manufacturer or 
dealer to determine whether these electronic circuits will perform normally 
when the radio is transmitting.

Preparation when Drilling Holes
Warning!! When drilling holes in the vehicle, check that drilling 

at the selected points will not damage existing wiring, 
petrol tanks, fuel lines, brake pipes, or battery cables.

Vehicles Powered by Liquefied Petroleum Gas

Warning!! Radio installation in vehicles powered by LPG 
(liquefied petroleum gas) with the LPG container in a 
sealed-off space within the interior of the vehicle must 
conform to the National Fire Protection Association 
Standard NFPA 58. This standard states that the radio 
equipment installation must meet the following 
requirements:

■ The space containing the radio equipment shall be isolated by a 
seal from the space containing the LPG container and its fitting.

■ Outside filling connections shall be used for the LPG container 
and its fittings.

■ The LPG container space shall be vented to the outside of 
the vehicle.

Radio Installation in Gas or Fuel tankers

Special conditions must be observed when installing a radio on gas and fuel 
tankers. Consult your radio provider or Tait-accredited service center for 
more details.
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Non-standard Radio Installations

The installation U-bracket has been designed so that there is enough airflow 
around the radio body to provide cooling.

If a non-standard installation method is used, care must be taken that 
sufficient heat can be dissipated from the heatsink fins and the ridged bottom 
surface of the radio. 

For this to be achieved, there must be a gap of more than 10 mm (3/8 inch) 
between the bottom surface of the radio chassis and the mounting surface. 
This is illustrated in Figure A.

Figure A Gap between radio chassis and mounting surface

Negative Earth Supply

The radios are designed to operate only in a negative earth system.

10 mm (3/8 in.)

mounting surface
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1 Preparing the Installation

This section contains the following information:

■ Regulations

■ Installation Tools

■ Unpacking and Checking the Equipment for Completeness

■ Installation Considerations

■ Installation Overview.

1.1 Regulations

MPT 1362 Code of 
Practice

TM8260 mobile radio systems should be installed in accordance with the 
MPT 1362 Code of Practice.

Vehicle 
Manufacturer�s 
Installation 
Instructions

Follow your vehicle manufacturer’s instructions for installing mobile radios. 
For more information, refer to the vehicle manufacturer’s website or contact 
the vehicle manufacturer’s dealer.

1.2 Installation Tools

The following tools are required to install the radio system:

■ drill and drill bits

■ 5mm (3/16 inch) flat-bladed screwdriver

■ Torx T-10 screwdriver

■ Torx T-20 screwdriver

■ Pozidriv screwdriver

■ 8 mm (5/16 inch) socket

■ wire cutters/strippers

■ RF connector crimp tool

■ fuse crimp tool

■ in-line RF power meter capable of measuring forward and reflected 
power at the operating frequency of each radio.

1.3 Unpacking and Checking the Equipment for Completeness

To install a dual-radio system (two radio bodies connected to one control 
head), you require the following equipment.

■ 2 x TM8260 radio bodies (for example, TMAB22-B100B and 
TMAB22-H600B). The firmware of the radio bodies must be the same 
(see “Required Programming Application and Firmware Versions” on 
page 31). Each body must also have the SFE (software feature enabling) 
key for Multi-Body Support (TMAS016).
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■ 2 x body remote interfaces (TMAC31-0T), with hardware subassembly 
XMAC31 revision 0021 (or later), and PCB 220-01720-05 (or later).

■ 2 x installation kits suitable for the radio bodies, for example, the 
TMAA03-17 installation kit (40W/50W radios), or TMAA03-01 
installation kit (25W radios).

Note Installation kits are also available without the U-bracket included 
and with other antenna connector options. Other cradle mounting 
arrangements are also available. Consult your nearest Tait Dealer or 
regional office for more information.

Warning!! Danger of fire. The radio’s protection mechanisms rely 
on the correct fuses on both the negative and positive 
power supply leads being present. Failure to fit the 
correct fuses may result in fire or damage to the radio.
The correct fuse types are:

■ 40W/50W radios: 20A fuses (Tait IPN 365-00010-81) 

■ 25W radios: 10A fuses (Tait IPN 365-00010-80).

■ TM8200 graphical-display control head (TMAC40-0T), with the same 
firmware version as the radio bodies (see Figure 3.2 on page 31), and 
hardware subassembly XMAC40 revision 0091 (or later).

■ control head remote kit (TMAA03-03), with hardware subassembly 
XMAA03-03 revision 0031 (or later), and PCB 220-01721-04 (or later).

■ any supported TM8000 microphone, for example, rugged (TMAA02-
01) or keypad (TMAA02-08).

■ control head remote cable (TMAA04-01).

■ radio connecting cable (TMAA04-03).

■ 2 x antennas and antenna coaxial cable.

The following equipment is optional, and may need to be ordered separately.

■ 2 x remote speakers (TMAA10-03).

■ cross-band linking, GPS, and external interface cable (TMAA04-06).

■ components to connect the radio system to an external alert device.

■ components to connect the radio system to an ignition signal.

■ GPS antenna/receiver (TMAA05-01) with plate mount (TMAA05-03) 
or magnetic mount (TMAA05-04).

1.4 Installation Considerations

Inspect the vehicle and determine the safest and most convenient position 
for mounting the radio bodies and control head, and routing the various 
cables. The radio bodies must be less than 1.5m (4.9ft.) apart. The control 
head must be no further than 6m (19.6ft.) from the connecting radio body.

1. For more information on how the hardware subassembly revision number relates to 
your serial number, contact your regional office or Tait Technical Support (see 
“Contact Information” on page 2).
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1.5 Installation Overview

Figure 1.1 summarizes how the components in a TM8260 dual-radio 
system are installed. For more detailed instructions, see “Installing a Dual-
Radio System” on page 15.

Figure 1.1 TM8260 installation overview

b external speaker j control head

c flying lead connector 1) any supported microphone

d cross-band linking, GPS, and 
external interface cable

1! external auxiliary interface 
(e.g. external alert device)

e radio body 1@ GPS antenna/receiver

f body remote interface 1# radio body

g connector seal 1$ body remote interface with 
link J4 removed

h radio connecting cable 1% control head remote cable

i control head remote 
interface

d

e
1#

f

h
1%

i

j

To antenna To second antenna

To power supply To power supply

To external I/O 1!

To speaker b To speaker b

To GPS 1@

To microphone 1)

g

Optional

Required

1$

c
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2 Installing a Dual-Radio System

This section contains the following information:

■ Installing a Basic Dual-Radio System

■ Advanced Dual-Radio Installation

■ Checking the Installation.

2.1 Installing a Basic Dual-Radio System

Before you start, make sure you have all the necessary tools and components. 
See page 11 for more information.

To install a basic dual-radio system:

1. Download MAC addresses to all devices in the system. See 
“Downloading MAC Addresses” on page 16.

2. Remove link J4 from the radio body interface that will be connected 
to the control head. See “Removing Link J4” on page 17.

3. Assemble the body interfaces. See “Assembling the Body Interfaces” 
on page 19.

4. Assemble the control-head interface. See “Assembling the Control 
Head Interface” on page 20.

5. Mount the control head and radio bodies. See “Mounting the 
Control Head and Radio Bodies” on page 21.

6. Install the antennas. See “Installing the Antennas” on page 21.

7. Connect the control head and radio bodies. See “Installing the 
Control Head Remote and Radio Connecting Cables” on page 23.

8. Connect the radios to a power source. See “Connecting the Power 
Cables to a Power Source” on page 25.

9. Program the radio system. See “Programming a Dual-Radio System” 
on page 31.
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2.1.1 Downloading MAC Addresses

Every device in a dual-
radio system must have a 
system configuration 
table (SCT) downloaded, 
with unique MAC 
(media access control) 
addresses (Figure 2.1). 
This enables you to read, 
program, and upgrade all 
devices in the radio 
system via the control 
head microphone port. 
Complete the following steps before installing the remote interfaces and 
assembling and mounting the system.

1. From the Programming Application, click Tools > Multiple Device 
Configuration.

2. Make sure a table similar to Figure 2.2 is displayed in the dialog.

Note The radio body with the lowest MAC address determines the 
foreground radio the first time the system is turned on, and each 
subsequent time if the Power-up on Last Active Body check 
box is cleared in the programming application.

Either:
■ click File > Open, and open the device configuration file for the 

system, or 
■ click Edit > Add Device and define the table.

Important The system configuration table must be downloaded to 
devices in the order stated within these steps. If not, then 
the control head may receive the same address as a radio 
body and you will no longer be able to communicate with 
all or part of the system.

Important The entire table must be downloaded to each device, not 
just information about the device that the table is intended 
for. See Figure 2.1.

Figure 2.2 Example of a system configuration table

Type Name MAC Priority

Head (TMAC40) Head 2 2

Body (TMAB22) VHF Radio 1 1

Body (TMAB22) UHF Radio 3 3

Figure 2.1 Devices with SCTs downloaded

Type MAC Priority

TMAC40 2 2

TMAB22 1 1

TMAB22 3 3 Type MAC Priority

TMAC40 2 2

TMAB22 1 1

TMAB22 3 3

Type MAC Priority

TMAC40 2 2

TMAB22 1 1

TMAB22 3 3
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3. Connect the control head directly to the radio body that you want to 
assign with the highest numerical MAC address value (in the example 
table in Figure 2.2, this is the UHF radio), and apply power. See 
Figure 2.3.

Important Connect one radio body at a time. Do not attempt to 
download MAC addresses if both radio bodies are 
connected together and have power applied.

4. Connect the control head microphone port to your PC.

5. Click Radio > Download MAC Address, and download the table 
to device TMAB22 with the higher address.

6. Connect the control head directly to the radio body that will have the 
lowest numerical MAC address value (in the example table in 
Figure 2.2, this is the VHF radio), and apply power. See Figure 2.4.

7. Click Radio > Download MAC Address again, and download the 
same table to device TMAB22 with the lower address.

8. Click Radio > Download MAC Address a third time, and 
download the same table to the control head (device TMAC40).

9. Check that all red indicators in the table are now green.

2.1.2 Removing Link J4

Every body remote interface (TMAC31-0T) is manufactured, by default, 
with a 120Ω termination resistor across the RS485 signal lines. The control 
head remote (TMAA03-03) also has this termination.

Figure 2.3 UHF radio body connected 
directly to the control head

Figure 2.4 VHF radio body connected 
directly to the control head

To 
power 
supply

To PC

Control head loom

VHF radio UHF radio

Control head

To power supply

To PC

Control head loom

VHF radio UHF radio

Control head 
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This termination is required at the ends of an RS485 network. In the case 
of a TM8260 dual-radio system, the radio body with the two connections 
(to the control head and to the other radio body) is a node on the network 
and must not have this termination.

To remove this termination, use your fingernail (or similar) to remove the 
jumper (shorting link) J4. Link J4 is located between the two RJ45 
connectors (see Figure 2.5), and can be removed without removing the 
PCB.

This must only be removed on the body remote interface connected to the 
control head (see “Installation Overview” on page 13), and can only be 
removed when the interface is separate from the radio body. If the interface 
has already been installed, see “Removing the Body Interface” below.

Removing the Body 
Interface

1. On the underside of the 
radio, insert a 5mm (3/
16in.) flat-bladed 
screwdriver between the 
body interface and the seal, 
in the positions shown 
(Figure 2.6).

Insertion points and are 
lever points and are indi-
cated on the radio chassis by a dot-dash-dot pattern (•–•).

Caution Take care that the seal is not damaged. Damage to this seal 
reduces environmental protection.

2. Use the screwdriver to lift the remote interface off the chassis clip, 
then repeat in the other position.

You should now be able to inspect, and if necessary remove, shorting 
link J4. It is not necessary to remove the body interface loom or the 
earthing tag to remove the link.

Figure 2.5 Location of Link J4

Link J4

RJ45 Connectors

Figure 2.6 Removing the Body Interface

lever point

seal

indication of 
lever point
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2.1.3 Assembling the Body Interfaces

The following steps show how to connect a body remote interface to a radio 
body. Complete these steps for both radio bodies.

Important One remote interface must have link J4 removed. See 
“Removing Link J4” on page 17 for more information. 
After you install the interface with link J4 removed, make 
sure you can identify that radio body when connecting the 
cables afterwards.

1. Screw the 
earthing tag 
onto the left 
screw boss on 
the radio 
chassis, using 
the Torx T-10 
screw provided.

2. Plug the body-
interface loom 
onto the 
control-head 
connector.

3. Insert the 
bottom edge of 
the control 
head onto the 
two clips in the 
front of the 
radio chassis, 
then snap into 
place.
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2.1.4 Assembling the Control Head Interface

The following steps show how to connect the control head remote interface 
to the control head. 

1. Undo the two Torx 
T-20 screws and 
remove the adaptor 
flange.

2. Unplug the control-
head loom and discard.

3. Plug the control-head 
interface loom into the 
connector on the 
control head.

4. Use the two Torx T-20 
screws from the first 
step to fit the control-
head remote interface 
to the control head. Be 
careful not to damage 
the space-frame seal.



TM8260 Installation and Programming Guide Installing a Dual-Radio System 21
© Tait Electronics Limited June 2006

2.1.5 Mounting the Control Head and Radio Bodies

Use the bracket and screws provided to mount the control head. The control 
head must be no further than 6m (19.6ft.) from the radio body with link J4 
removed.

Mount the two radio bodies less than 1.5 metres (4.9ft.) apart using the 
preferred mounting method (such as U-brackets, slide-in cradles, or security 
brackets).

For more information, refer to the instructions included with the cradle or 
bracket installation kit.

2.1.6 Installing the Antennas

A separate antenna for each radio is recommended, rather than a single 
antenna configuration (such as a multi-band antenna with a duplexer or 
splitter). See “Installation Overview” on page 13. Use ground-independent 
antennas if no suitable ground plane is available.

It is important that the antennas are separated as far as possible from each 
other to reduce interference. MPT 1362 recommends a separation of at least 
¼ wavelength for transmit frequencies below 600 MHz and one wavelength 
for transmit frequencies above 600MHz. See Table 2.1 below, and 
“Regulations” on page 11.

If dual-transmit will be used for extended periods of time, the antennas must 
be separated even further (such as on opposite widths of the vehicle).

Install the antennas according to the antenna manufacturer’s instructions. 
Good quality 50Ω coaxial cable must be used, such as RG58 or UR76.

Table 2.1 Approximate frequency to wavelength conversion

Band Name Frequency (MHz) Wavelength (cm)
1/4 Wavelength 
(cm)

A4 (lower range) 66 454 114

A4 (upper range) 88 341 85

B1 (lower range) 136 220 55

B1 (upper range) 174 172 43

H6 (lower range) 450 67 17

H6 (upper range) 530 57 14
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Important Route the cables in a manner that minimizes:

■ coupling into the electronic control systems of 
the vehicle

■ coupling of electric vehicle systems, such as alternators, 
into the radio

Avoid sharp bends in the cables. These distort the cable and 
alter its electrical characteristics.

Warning!! RF exposure hazard

To comply with FCC RF exposure limits:

1. Mount the antennas at a location such that no person or persons can 
come closer than 35 inches (0.9m) to the antenna.

2. For 40W/50W radios:
■ VHF radios must be installed using an antenna mounted centrally 

on the vehicle roof, with a gain of 2.15dBi or 5.15dBi.
■ UHF radios must be installed using an antenna mounted either 

centrally on the roof with a gain of 2.15dBi or 5.65dBi, or 
centrally mounted on the trunk with a gain of 5.65dBi.

3. For 25W radios, the radio must be installed using an externally 
mounted antenna with a gain of either 2.15dBi or 5.15dBi.

Terminating the 
Antenna Cable

1. Run one antenna cable (not supplied) from an antenna to the 
mounting location of the matching radio body. Cut the cable to 
length, allowing approximately 20 cm (8in.) excess at the radio end.

2. Terminate the free end of the antenna cable with the mini-UHF plug 
or BNC plug (supplied) as shown in Figure 2.7.

3. Repeat steps 1 and 2 for the other antenna and matching radio body.

Figure 2.7 Terminating the antenna cable
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2.1.7 Installing the Control Head Remote and Radio Connecting Cables

Figure 2.8 contains an overview of the connections between the radio 
bodies and the control head. For information on the pins and signals of all 
ports, see “Pins and Signals” on page 24.

Detailed Steps

Figure 2.8 Overview of connections between radio bodies and control head

Port A Port B
Body 1 (link J4 fitted) Body 2 (link J4 removed)

CH Port

Port A Port B

Control Head
Radio connecting cable
TMAA04-03 (1.5 m / 4.9 ft.)

Control head remote cable 
TMAA04-01 (6 m / 19.6 ft.)

1. Remove all connector 
seals.

2. Attach one end of the 
control head remote 
cable to port B of the 
radio body with link J4 
removed.

3. Attach the other end of 
the cable to the rear 
port of the control 
head.

Important If a radio body does not have link J4 removed, or you 
cannot identify the correct radio body to use, you will need 
to disassemble one or both interfaces. See “Removing the 
Body Interface” on page 18 for more information.
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Pins and Signals The pinouts in Table 2.2 are for the two RJ45 ports on the radio body 
interface, and single RJ45 port on the control head interface.

4. Attach one end of the 
radio connecting cable 
to port A of the body 
connected to the 
control head, and the 
other end to port B of 
the second body with 
link J4 fitted.

5. Insert a connector seal 
in the port with no 
cable (port A of the 
body with link J4 
fitted).

Table 2.2 Remote Interface Ports�Pins and Signals

Pin Name Description

1 RX_AUDIO Analogue receive 
audio – after volume 
control.

2 13V8 Default setting is a 
switched +13V8 
line.

3 RS485+ RS485 data.

4 AGND/PTT Default setting is 
analogue ground.

5 MIC AUDIO Analogue electret 
mic input.

6 RS485 RS485 data.

7 DGND Digital ground.

8 ON/OFF Radio on/off control.

front view
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2.1.8 Connecting the Power Cables to a Power Source

To provide power to TM8260 radio systems, you must connect each radio 
body separately to a power source or sources. TM8260 radio systems do not 
currently support a single lead-to-battery connection.

It is important to ensure that both radio bodies have a solid and secure power 
supply. Unexpected behaviour can arise if the power supply to one body 
operates at a lower voltage than the other, or is momentarily interrupted, as 
might occur with a poorly formed or intermittent wiring termination.

Important Each radio is designed to operate from a nominal 12V 
negative ground supply. Each radio may draw up to 15A of 
current. Each radio will tolerate a supply voltage range of 
10.8V to 16.0V at the radio.

Selecting the Power 
Source

In passenger vehicles, the radio system is always connected directly to the 
battery. 

In trucks, where direct connection to the battery is often not possible, each 
radio can be connected to a suitable terminal inside the fuse box that is 
connected directly to the battery.

24V-to-12V 
Converter

In vehicles with a supply voltage larger than 16.0V, such as many trucks, it 
is essential to provide a suitably rated 24V-to-12V converter. This will 
isolate the radios from excessive battery voltage and provide the correct DC 
operating conditions. Note that most 24V-to-12V converters already fitted 
are not rated sufficiently.

Standby Current When using the ignition signal to turn off the radio system, the standby 
current is reduced to <6mA. Otherwise, the standby current is 
approximately 60mA.

Connecting the 
Power Cable

Important Although it is possible to connect the radio system in line 
with the vehicle ignition, this is not recommended, as it 
may draw too much current and damage the vehicle wiring 
and steering column or ignition switch. This may also cause 

Table 2.3 Radio body power connector�pins and signals

Pinout Pin Signal name Description Signal type

1 AGND Earth return for radio body power source Ground

2 SPK– External speaker output. Balanced load 
configuration

Analog

3 SPK+ External speaker output. Balanced load 
configuration

Analog

4 13V8 BATT DC power input for radio body and 
control head

Power

rear view

40W/50W radio

1 2 3 4

rear view

25W radio
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the supply voltage of the radio to drop below the specified 
level.

Important Disconnecting the vehicle’s battery may cause problems 
with some electronic equipment, such as vehicle alarms, 
engine management systems, and in-car entertainment 
systems. Check that the vehicle owner has the necessary 
information to make all electronic equipment function 
correctly after battery reconnection.

Important If the battery is not disconnected, exercise extreme caution 
during the installation and install the fuses only when the 
installation is ready to be checked. For more information, 
refer to “Checking the Installation” on page 28.

1. Disconnect the vehicle’s battery unless specifically prohibited from 
doing so by the customer, vehicle manufacturer, agent, or supplier.

Important Route the cables in a manner that minimizes coupling of 
electric vehicle systems such as alternators into the radio.

Important Protect the power cables from engine heat, sharp edges and 
from being pinched or crushed.

2. Run the power cable between one radio’s mounting position and the 
power source and cut it to length, allowing approximately 20 cm 
(8 in.) excess at the radio end.

3. Plug the power cable into the power connector of the radio.

4. Cut the negative (black) and the positive (red) wires where the in-line 
fuse holders will be placed (as close to the power source as possible).

Important Do not install the fuses until the installation is ready to be 
checked. For more information, refer to “Checking the 
Installation” on page 28.

5. Insert each end of the negative wire into each of the fuse crimp-
terminals and crimp them to force the metal contacts onto the wires.

6. Push the two crimp-terminals into the clear plastic fuse cover. Close 
the cover while the next steps are completed.

7. Repeat steps 5 and 6 for the positive wire.

8. Connect the negative wire to the battery ground terminal.

9. Connect the positive wire to the battery positive terminal.

10. Repeat steps 2 to 9 for the other radio body.

Important Do not install the fuses until the installation is ready to be 
checked. For more information, refer to “Checking the 
Installation” on page 28.
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Power During Radio 
Operation

It is important that both radio bodies power on at the same time. If that does 
not happen (for example, the Power On Mode is set to Power On in the 
programming application and power is applied to each body in sequence) 
you must turn the system off then on again via the on/off key. It is not 
recommended that you remove or apply power to a single radio body while 
operating the radio system.

If power to one radio body is disrupted, you must turn the system off then 
on again via the on/off key. If there is no power supply to one radio body 
after the radio system is switched on, the other body and control head will 
continue to operate as a single radio unit.

Important The ignition signal may fail to turn the remaining radio 
body on and off if there is no power to one radio body. In 
this situation, the on/off key must be used to continue 
operating the radio.

2.2 Advanced Dual-Radio Installation

This section contains the following information about additional features:

■ Connecting Remote Speakers

■ Connecting the Cross-band Linking, GPS, and External Interface Cable

2.2.1 Connecting Remote Speakers

Remote speakers can be installed with one or both radio bodies, to operate 
in parallel with the control head’s existing internal speaker. The remote 
speakers can be installed at some distance from the control head, or can be 
used to increase the volume of the audio from the internal speaker.

The remote speaker will only sound audio from the radio that it is connected 
to. Audio is never fed to a remote speaker from the other radio body. If a 
radio is at the background and dual receive is activated, the attached remote 
speaker will sound received audio from that radio at a reduced volume. If a 
radio is at the foreground, the attached remote speaker will sound received 
audio from that radio at full volume, and audible indicators.

The following high-power remote speakers are recommended:

■ TMAA10-06 high-power remote speaker for 40W/50W radios

■ TMAA10-03 high-power remote speaker for 25W radios. 

If a different speaker is used, receptacles for the speaker pins of the power 
connector are provided with the installation kit. The installation kit also 
contains a flying lead connector that, when installed, enables the speaker to 
be easily removed and re-installed as required.
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The speaker is connected to pins 2 (SPK–) and 3 (SPK+) of the power 
connector. See Table 2.3 on page 25. For more information, refer to the 
installation instructions provided with the speaker, or to the relevant section 
of the service manual.

2.2.2 Connecting the Cross-band Linking, GPS, and External Interface 
Cable

To enable cross-band repeater operation, a linking cable TMAA04-06 must 
be attached between the auxiliary connectors of the radio bodies. 
Programmable I/O and external PTT 1 settings must also be programmed 
using the programming application.

To enable dual-body GPS operation, the linking cable also provides a single-
point connection to a GPS antenna. The GPS connector is the correct type 
for the antenna, therefore the adaptor that is supplied with the GPS antenna 
is not required. For GPS information to be displayed on the radio, you must 
purchase and program the software feature enabling (SFE) key for GPS 
Support (TMAS015).

The cable also provides access to certain programmable I/O lines. These 
lines can be used to power a TM8260 system on using ignition sense, and 
provides an output for a dual-body external alert.

For more information, refer to Appendix A on page 39.

2.3 Checking the Installation

Warning!! Danger of fire. The radio’s protection mechanisms rely 
on the correct fuses on both the negative and positive 
power supply leads being present. Failure to fit the 
correct fuses may result in fire or damage to the radio.
40W/50W radios use 20A fuses; 25W radios use 10A 
fuses. For part numbers of the fuses, refer to 
“Unpacking and Checking the Equipment for 
Completeness” on page 11.

1. Insert the fuses into the power leads. The radio will turn on 
automatically at this point. 

2. Switch the radio off then on again using the front panel control, but 
do not transmit.

3. Connect an in-line power meter between one radio and its antenna.

4. Transmit and measure the forward and reflected power levels.

Less than 4% of the forward power should be reflected. If this is not 
achieved, check the installation, including the antenna length.

5. Start reducing the length of the antenna in steps of 0.1 inches to 
0.2 inches (2 to 5 mm). Measure the power levels at each step.
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Important Some antennas are pre-tuned and must not be cut. Check 
with the manufacturers’ instructions.

6. Once the reflected power levels are within tolerance, repeat steps 3, 4 
and 5 for the second radio.

7. Test the dual-radio functions.
■ Compare the receive functions (such as sensitivity) of one radio, 

while the other radio is and is not transmitting. Ensure there is no 
significant difference.

■ Compare the transmit functions (such as coverage) of one radio, 
while the other radio is and is not transmitting.

■ Test all other functions, such as dual-receive and cross-band 
repeater operation. Check that those functions operate as 
expected.

If issues are found, move the radio bodies and/or antennas further 
apart and re-test.
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3 Programming the Radio System

After you have downloaded 
MAC addresses and assembled 
the system, you can select 
individual devices to read or 
program. Each time you attempt 
to communicate with the radio 
system, the Select Device(s) 
dialog appears (Figure 3.1).

This section contains the 
following information:

■ Programming a Dual-Radio 
System

■ Recommended Dual-Radio Settings

■ Upgrading Radio Firmware

■ Calibrating the Radio System

■ Troubleshooting.

3.1 Programming a Dual-Radio System

The following steps for programming a dual-radio system assume:

■ all the devices in the system have supported versions of firmware, and you 
have installed supported versions of programming and calibration 
software. See Figure 3.2.

■ all the devices in the system have unique MAC addresses assigned. See 
“Downloading MAC Addresses” on page 16.

■ all radio bodies in the system have the optional feature for dual-radio 
operation enabled. See “Checking the Optional Feature for Multi-Body 
Support” on page 36.

Figure 3.2 Required Programming Application and Firmware Versions

Software or Firmware Type Version Required

TM8200 Programming Application v3.00 or higher

TM8000 Calibration Application v2.91 or higher

Boot Code (radio bodies and control head) v1.04 or higher

Radio Application (radio bodies and control head) v3.01 or higher

FPGA Image (radio bodies and control head) v1.05 or higher

DSP (radio bodies) v3.01 or higher

Figure 3.1 Select Device(s) dialog
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Step 1�Create a 
template file

1. Using the Programming Application, enter the information into the 
fields that are common between the radios. See “Recommended 
Dual-Radio Settings” on page 33.

2. Click File > Save.

3. Enter a descriptive name for the template, for example, 
"TM8260_Master_File".

Step 2�Program 
each device in the 
system

1. Using the Programming Application, open the template file created 
for the radio system.

2. Set the radio’s Band (Global > Specification form).

3. Enter a Radio Name (recommended).

Note The length of the radio name restricts the length of all channel and 
group labels. Therefore a three-character radio name such as 
"UHF" or "VHF" is recommended, as it will allow group and 
channel labels up to 10 characters (such as "Channel 99").

4. Add all information relating to the band selected in step 2, including 
channels (Conventional > Channel Setup > Channels form) and 
groups (Scan Groups form).

5. Click File > Save As to save the device’s file to disk as a new file.

6. Click Radio > Program.

7. In the Select Device(s) dialog, select the radio body that matches the 
Band selected in step 2, and optionally, the control head. See 
Figure 3.1.

Note You cannot select more than one of the same device type (for 
example, two radio bodies). The Select Device(s) dialog will 
automatically select the radio body with the matching operating 
band (step 2).

Note The recommended sequence for programming a dual-radio system 
is a radio body (TMAB22-) in the first session, then the other body 
(TMAB22-) and the head (TMAC40-) together in the second 
session.

8. Repeat steps 1 to 7 and program the other radio body and the control 
head.
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3.2 Recommended Dual-Radio Settings

The programming configuration of all devices must be as similar as possible, 
with the exception of the operating band, radio name, channels and groups. 
If features relating to the user interface (such as function keys, radio menus, 
and backlighting), and other features like the security lock are different, 
there may be unexpected behaviour when powering on or switching 
between the radios.

The following settings are recommended for a dual-radio system. Use this 
table when setting up a template file, before programming the system (see 
“Programming a Dual-Radio System” on page 31).

Field/Feature Location Comments

Radio Name Global > Specifications 
form

The radio name, if used, should be different for 
both radio bodies in the system.

Power On Mode Global > Start-up form The power on mode must be the same for all 
devices in the system.

Power-up on Last 
Active Body

Global > Start-up form This check box must be the same for all devices 
in the system.

Reset on Error Global > Start-up form The Reset on Error check box must be the same 
for all devices in the system.

Security Lock on Power Up 
and Security PIN

Global > Start-up form If the security PIN is enabled, it must be enabled 
(and have the same PIN) for all devices in the 
system.

PTT fields Global > PTT form PTT settings for both radio bodies are used when 
in dual-transmit mode and the radio user presses 
the PTT. Care should be taken if programming 
PTT behaviour differently between the radio 
bodies. PTT settings are typically set the same for 
all devices in the system.

Startup (Channel or Group) Conventional > 
Conventional UI form

You can program this option for the foreground 
radio (the radio body with the lowest MAC 
address) to start on a specific channel or group 
each time the radio system is turned on. You can 
also program this option for the background 
radio to default to a specific channel or group 
after the radio system is turned on, and the radio 
user subsequently switches the active radio or 
enables dual receive.

Selcall Stun and Revive Conventional > Selcall > 
Control Status form

Selcall stun and revive functionality is currently 
not supported for TM8260 radio systems. If the 
stun and revive control status types are used, set 
the equivalent Rx Processing fields to No for all 
devices.
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Conv Key Settings Conventional > Conv Key 
Settings form

Dual body functionality such as dual transmit 
and receive, and changing the foreground radio, 
can only be accessed via function keys.
Add the Dual Body Mode and Single Body Mode 
actions to separate keys, or Dual/Single Body 
Mode to a single key.
Add the Switch Active Radio action to a different 
function key.

Other Function Key Settings 
and the Radio Menu

Conventional > 
Conventional Menu form

The radio’s function key settings (Conv Key 
Settings form) and menu (Conventional Menu 
form) must be the same for all devices in the 
system.

Left Selection Key and 
Scroll Keys

Conventional > Conv Key 
Settings form

If options are programmed for the left selection 
key and/or scroll keys, they must be the same for 
all devices in the system.

UI Preferences and 
Conventional UI

Global > UI Preferences 
form, and 
Conventional > 
Conventional UI form

UI preferences must be configured identically for 
all devices in the system. For example, 
backlighting, keypress tones, the RSSI icon, and 
the default dialling type.

Programmable I/O Programmable I/O form All radio body I/O pins are supported, and all 
actions are supported except the output F1 to F4 
Key Status. The control head I/O pin (CH_GPIO1) 
is limited to outputs only, and those outputs will 
always reflect the foreground radio.
The following actions are dependant on the 
current mode, and state of the active radio body.
External PTT 1 and 2: The radio body that the 
PTT is connected to will transmit, unless 
transmission is invalid (for example, that radio is 
the background radio in single-body mode).
Toggle F1 and F4 Key LED: The function key 
LED will reflect the state of the relevant I/O pin 
on the foreground radio.
Radio Ready: The radio at the background in 
single-body mode is not considered ready, so will 
not activate the output pin.
Note: the cross-band linking, GPS, and external 
interface cable requires specific programmable 
I/O settings for both radio bodies. For more 
information, see Appendix A on page 39.

Trunked MPT Trunked MPT settings are currently not 
supported with TM8260 radio systems. Do not 
attempt to program these fields or enable the 
optional feature for MPT 1327 Trunking.

Field/Feature Location Comments
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3.3 Upgrading Radio Firmware

The download dialog (from the programming application, click 
Tools > Download) contains a column called NTID. This shows the MAC 
(media access control) address for each device. When reporting a radio 
system’s configuration, the table will list the various types of firmware for all 
devices in the system.

Important Reporting the configuration will also show SCT (System 
Configuration Table) files for each device, which must exist 
for a radio system. These files are the result of downloading 
MAC addresses (see “Downloading MAC Addresses” on 
page 16). Do not attempt to delete these files.

When you download firmware to hardware of a particular type (for example, 
the target hardware shows as a radio body), it will be sent to all devices in 
the system of the same hardware type. The firmware will be downloaded to 
each device in sequence.

3.4 Calibrating the Radio System

TM8260 dual radio systems do not support calibration of the radio system 
as a whole. The system must first be disassembled to a single head / single 
body configuration. If calibration is required after repair, the radio body 
must be calibrated outside of the system before re-installation.

3.5 Troubleshooting

If reporting the configuration shows only two devices when three are 
expected, or the Select Device(s) dialog does not appear when reading or 
programming the radio system:

■ Make sure all cables are connected correctly, and securely.

■ Make sure power is applied to both radio bodies.

■ One or more devices may not have the correct system configuration table 
of MAC addresses. Re-download the table to all devices in the system. 
See “Downloading MAC Addresses” on page 16.

If an “incorrect band” message appears when attempting to program a radio 
body, the band of the selected device to program is different to the band 
selected in the programming application. Either change the Band field on 
the Specifications form, or select the matching radio body in the Select 
Device(s) dialog.

If an “unlicensed feature” message appears in the programming application, 
or the LEDs on one or both radio bodies flash on and off when powering 
up the system, the optional feature for Multi-Body Support may not be 
enabled. To check this, refer to the steps below.
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Checking the 
Optional Feature for 
Multi-Body Support

1. Click Tools > Optional Features from the programming 
application.

2. Connect the control head directly to one radio body, and to your PC. 
See Figure 2.3 or Figure 2.4 on page 17.

3. Click the Read Radio button.

4. Check that the Status is showing Enabled next to Multi-Body 
Support.

5. Repeat steps 2 to 4 for the other radio body.

If this feature is showing as Disabled for one or both radios, you will need 
obtain and program SFE (software feature enabling) keys. Contact Tait 
Electronics Limited for more information.
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4 Quick reference

❏ 
All components are present and are the correct 
versions of hardware and firmware.

See page 11.

❏ 
The system configuration table is downloaded to 
the control head and radio bodies.

See “Downloading MAC 
Addresses” on page 16.

❏ 
Link J4 is removed from the radio body connected 
to the control head.

See “Removing Link J4” on 
page 17.

❏ 
The remote interfaces are installed on the radio 
bodies and control head.

See page 19 and page 20.

❏ 
For each body remote interface, the earthing tag 
is attached onto the radio chassis.

See page 19.

❏ 
Antennas are connected to both radio bodies. See page 21.

❏ 
The cables are attached into the correct ports. See page 23.

❏ 
There is a solid and secure power supply to both 
radio bodies.

See page 25.

❏ 
The correct fuses are fitted to the power supply 
leads.

See page 28.

❏ 
The radio system is programmed so the user can 
access dual-radio features.

See “Programming a Dual-
Radio System” on page 31.
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Appendix A Cross-band Linking, GPS and External 
Interface Cable

This section contains the following information:

■ Introduction

■ Cross-band Repeater Operation

■ Connecting to a GPS Device

■ Connecting to the Ignition Signal

■ Connecting to an External Alert Device

■ Connecting to other External Devices or Signals

■ Interface Specification.

A.1 Introduction

The TMAA04-06 cross-band linking, 
GPS, and external interface cable is used 
to extend the features available with 
TM8260 dual radio systems. The cable 
connects to both radio’s auxiliary ports 
so the radio system can be used as a cross-
band repeater, provides an RJ45 socket 
to connect to a GPS antenna, and also 
provides an external interface connector. 
The external interface can be used to 
power a TM8260 dual radio system on 
using ignition sense, and also connect to 
an external alert device.

Important The radio does not meet the IP54 protection standard once 
the auxiliary connector rubber bungs have been removed 
and this cable has been installed. Care must be taken when 
the radio is being operated in an environment where there 
is water, dust or other environmental hazards.

A.2 Cross-band Repeater Operation

Cross-band repeater mode allows a TM8260 dual radio system be used as a 
temporary repeater. Any activity received on one radio will be automatically 
transmitted on the other radio, and vice versa.

External 
Interface 
ConnectorRJ45 GPS 

Socket

Auxiliary 
Connectors
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A.2.1 Installation

1. Remove the rubber bung that cover the auxiliary connector on each 
radio body.

2. Plug an auxiliary connector into the auxiliary port of a radio body.

3. Plug the second auxiliary connector into the auxiliary port of the 
other radio body.

Note The cable can be plugged in either way—its orientation has no 
impact on radio performance. However, to reduce the cabling 
required, orient the cable so the external interface connector and 
GPS socket are closest to the device or devices to connect to.

4. Tightly fasten the jackscrew-type locks.

A.2.2 Radio Programming

Programmable I/O 
and Audio Settings

At a minimum, settings in Table A.1, Table A.2, and Table A.3 must be 
programmed for both radios.

Notes: 1. Select Busy Status and Busy Detect to re-transmit any signal.

2. Select Signalling Audio Mute Status and Busy Detect + Subaud to 
transmit valid signalling only. This is recommended if the repeater is to 
operate on a scan group where member channels require valid 
subaudible signalling. Otherwise the radio may re-transmit short bursts 
of activity when a channel is busy but not captured due to invalid activity.

Table A.1 Cross-band settings in the Programmable I/O form, Digital tab

Pin Mode Direction Label Action Active Debounce

AUX_GPI1 Conventional Input XBAND_TX Crossband Tx Input Low 10

AUX_GPIO5 Conventional Output BUSY
Busy Status1

Low None
Signalling Audio Mute Status2

Table A.2 Cross-band settings in the Programmable I/O form, Audio tab

Pin Tap In Tap In Type
Tap In 
Unmute

Tap Out
Tap Out 
Type

Tap Out Unmute

Rx None A-Bypass In On PTT R7 D-Split
Busy Detect1

Busy Detect + Subaud2

EPTT1 T5 A-Bypass In On PTT None C-Bypass 0 On PTT

Table A.3 Cross-band settings in the PTT form, External PTT (1) tab

Field Setting

Advanced EPTT1 PTT Transmission Type Voice

Audio Source Audio Tap In
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Receive and Transmit 
Settings

The cross-band repeater receives signals based on the radio’s squelch (carrier) 
mute, and re-transmits signals based on external PTT 1. If programmed to only 
re-transmit valid signals, the radio’s signalling mutes are also taken into account, 
which are affected by the radio’s monitor function (such as the hookswitch 
monitor when the microphone is off the hook). If monitor settings are 
programmed, the radio user must not enable monitor (such as having the 
microphone off the hook) while entering, or during, cross-band repeater mode.

The transmit timer, if enabled, limits the maximum duration of cross-band 
repeater transmissions. If a transmit lockout period is programmed then 
further repeater transmissions will also be inhibited until the lockout timer 
expires. However, if a valid received signal is present when the lockout timer 
expires then the radio does not automatically resume transmission.The 
received signal must first drop and return before re-transmission resumes.

Priority scanning also affects the transmit timer during cross-band repeater 
transmissions. If a non-priority channel in the group is captured, the radio 
will re-transmit that activity and the transmit timer will begin counting 
down. However, each time the radio samples the priority channel or 
channels there is a brief break in reception, which will cause the transmit 
timer to restart.

Squelch override is not compatible with cross-band repeater operation. 
Avoid programming this feature to a function key, and consider removing 
the menu option.

Transmit Inhibit If both radios are receiving activity when cross-band repeater mode is 
activated, the radio system can rapidly cycle between transmit and receive. 
Set Tx Inhibit to Busy to prevent this from happening by not allowing the 
radio system to transmit when there is another busy signal. An alternative is 
to set different debounce times for each radio (such as 10 and 100 ms), 
which will separate each radio’s entry into cross-band repeater mode.

If the cross-band repeater is programmed to only re-transmit valid signals, 
and one radio is receiving an invalid signal (such as invalid CTCSS), the 
mute will stay closed and no re-transmission will occur. However, if the 
other radio then receives a valid signal, the radio will attempt to re-broadcast 
this over the other signal. Set Tx Inhibit to Busy or Mute to prevent this 
re-transmission occurring.

System Timing For the cross-band repeater to operate correctly with other base stations or 
repeaters, system timing must be taken into account. If using subaudible 
signalling and the transmitter requires a “tail”, then this can be configured 
according to Table A.4. During the lead-out delay period, no signalling, 
such as CTCSS or DCS, is present.

Table A.4 Transmit tail in the Basic Settings form, Subaudible Signalling tab

Field Setting

CTCSS Settings Lead-Out Delay any duration, up to 1000ms

DCS Settings Lead-Out Delay any duration, up to 1000ms
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A.2.3 Operational Testing

1. Enable cross-band repeater mode.

2. On the receiving radio, inject an on-channel RF signal at a level of 
-70dBm, modulated to ±3kHz deviation (wide bandwidth channel) 
or ±1.5kHz (narrow bandwidth channel), at 1kHz AF.

3. On the transmitting radio, the resulting deviation should be:
■ ±3kHz (with a tolerance of ±200Hz) on a 25kHz wide 

bandwidth channel.
■ ±1.5kHz (with a tolerance of ±200Hz) on a 12.5kHz narrow 

bandwidth channel.

A.3 Connecting to a GPS Device

The cable provides an RJ-45 socket, which is used to connect a TM8260 
dual radio system to a GPS device such as a Garmin-16HVS antenna/
receiver (product code TMAA05-01). GPS data is sent from the antenna to 
both radios.

A.3.1 Installation

Plug the GPS receiver/antenna directly into the RJ-45 socket. The socket 
is the correct type for the antenna, therefore the adaptor that is supplied with 
the GPS antenna is not required. For information on antenna mounting, 
refer to the instructions provided with your GPS device.

A.3.2 Radio Programming

Program one or both radios with GPS settings as required. For detailed 
configuration and programming information contact your local Tait dealer.

A.4 Connecting to the Ignition Signal

The cable’s external interface connector can be used to connect a TM8260 
dual radio system to the vehicle’s ignition signal. This will turn the radio 
system off when the ignition key is off to avoid draining the battery, and will 
turn the radio system on when the ignition key is on.

Note A TMAA04-05 ignition sense kit is available. The kit comprises a 
mating plug for the radio’s auxiliary connector and a 13 foot (four 
metre) length of cable to connect to the vehicle’s ignition signal.
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A.4.1 Installation

Connect pin 4 of the external interface connector (AUX-GPI3) to the 
13.8V signal controlled by the vehicle’s ignition key.

Important Make sure the ignition switch and the radio links LK1 and 
LK2 are properly configured to reduce the radio's power 
consumption. Refer to the TM8200 Service Manual for 
more information.

A.4.2 Radio Programming

Program both radios as shown in Table A.5.

A.5 Connecting to an External Alert Device

The cable’s external interface connector can be used to connect a TM8260 
dual radio system to an external alert device in the vehicle. This enables both 
radios to drive the same external alert device.

A.5.1 Installation

The external alert lines used to connect to an external device are open 
collector outputs. Connect pin 9 (radio closest to connector) and pin 10 
(radio furthest from connector) of the external interface connector to an 
input on the interface to the external alert device. Connect the pins together 
to drive the same external alert device. Connect the pins separately to drive 
separate external alert devices.

Important The high current sink capability of the radio’s auxiliary lines 
cannot be accessed with this cable. That means you cannot 
connect directly to an external alert device—an interface to 
the external alert (such as a controller box) must be used.

Important The internal pullups normally available from the auxiliary 
lines are not available via this cable. If the external alert 
requires a logic-type signal on the output lines, the lines 
must be pulled up to a suitable voltage level by an external 
resistor.

Table A.5 Ignition sense settings in the Programmable I/O form, Digital tab

Pin Mode Direction Label Action Active Debounce

AUX_GPI3 All Input IGN_SENS Power Sense 
(Ignition)

High 10
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A.5.2 Radio Programming

Program both radios as shown in Table A.6.

A.6 Connecting to other External Devices or Signals

The cable does not currently support any other programmable I/O actions, 
or connection to other external devices or signals.

A.7 Interface Specification

The following tables summarize the signals used for all connectors on the 
cable, and shows the interfaces between the cable and the radios.

Table A.6 External alert settings in the Programmable I/O form, Digital tab

Pin Mode Direction Label Action Active Debounce

AUX_GPIO6 Conventional Output EXT_ALRT External Alert 1 Low None

Figure A.1 Auxiliary connectors�pins and signals

Pin Signal name Description

2 AUX_GPIO5 busy (output)

3 RXD receive data

4 AUX_GPI3 ignition sense

7 AUD_TAP_IN audio tap input

8 +13V8 power supply to GPS device

9 AUX_GPIO6 external alert

12 AUX_GPI1 PTT (input)

13 AUD_TAP_OUT audio tap output

15 AGND ground

rear view

J
B

C

D

E

F

G

H

I
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1!
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1#

1$
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Figure A.2 GPS socket�pins and signals

Pin Signal name Description

1 +13V8 power supply from radio

2 GND ground

3 GND ground

5 GPS_TXD transmit data

front view
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Figure A.3 External interface connector�pins and signals

Pin Signal name Description

4 AUX_GPI3 ignition sense

9 AUX_GPIO6 external alert (radio closest to 
connector)

10 AUX_GPIO6 external alert (radio furthest from 
connector)

15 GND groundrear view

J
B

C

D

E

F

G

H

I

1)

1!

1@

1#

1$

1%



46 TM8260 Installation and Programming Guide
© Tait Electronics Limited June 2006



TM8260 Installation and Programming Guide Glossary 47
© Tait Electronics Limited June 2006

Glossary

background radio The radio in a dual-radio system that is not currently showing on the radio 
display, or is showing in a smaller font.

control head The device in a radio system that provides the user-interface.

cross-band linking, 
GPS, and external 
interface cable

A cable used to connect the auxiliary ports of the two radio bodies in a dual-
radio system. The cable enables the radio system to be used as a cross-band 
repeater, provides an RJ45 socket to connect to a GPS antenna, and also 
provides an external interface connector.

cross-band repeater A mode in a dual-radio system where the system receives on one radio, and 
immediately re-transmits that reception on the other radio.

device A component (control head or radio body) in a radio system. A device is 
known as target hardware when upgrading radio firmware.

dual body mode The function on a dual-radio system that enables you to turn on dual receive 
and dual transmit

dual-radio system A control head connected to two radio bodies.

dual receive A state in a dual-radio system where the system receives on both the 
foreground radio and background radio simultaneously.

dual transmit A state in a dual-radio system where the system transmits on both the 
foreground radio and background radio simultaneously. Dual transmit 
includes dual receive.

foreground radio The radio in a dual-radio system that is currently showing on the radio 
display, or showing in a larger font.

MAC address The unique identifier that is assigned to each device in a radio system.

primary radio The radio body in a dual-radio system with the lowest MAC address. The 
primary radio is at the foreground each time the system is turned on.

radio A radio body, when connected directly or indirectly with a control head.

radio body The device in a radio system that provides standalone transmit and receive 
on a single operating band, and also other functionality such as digital 
processing. Also known as a torso.

radio system See dual-radio system.
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single body mode The function on a dual-radio system that enables you to return to single 
receive and single transmit.

single receive and 
single transmit

A state in a dual-radio system where the system transmits and receives on the 
foreground radio only.

system configuration 
table

The table that is downloaded to every device in a radio system. The table 
contains information about the system, including all devices, device names, 
MAC addresses, and priorities.



TM8260 Installation and Programming Guide Tait General Software Licence Agreement 49
© Tait Electronics Limited June 2006

Tait General Software Licence Agreement

This legal document is an Agreement between you (the 
“Licensee”) and Tait Electronics Limited (“Tait”). By using any 
of the Software or Firmware items prior-installed in the related 
Tait product, included on CD or downloaded from the Tait 
website, (hereinafter referred to as “the Software or Firmware”) 
you agree to be bound by the terms of this Agreement. If you do 
not agree to the terms of this Agreement, do not install and use 
any of the Software or Firmware. If you install and use any of the 
Software or Firmware that will be deemed to be acceptance of the 
terms of this licence agreement.
The terms of this Agreement shall apply subject only to any 
express written terms of agreement to the contrary between Tait 
and the Licensee.

Licence
TAIT GRANTS TO YOU AS LICENSEE THE NON-EXCLUSIVE 
RIGHT TO USE THE SOFTWARE OR FIRMWARE ON A SINGLE 
MACHINE PROVIDED YOU MAY ONLY:
1. COPY THE SOFTWARE OR FIRMWARE INTO ANY MACHINE 
READABLE OR PRINTED FORM FOR BACKUP PURPOSES IN 
SUPPORT OF YOUR USE OF THE PROGRAM ON THE SINGLE 
MACHINE (CERTAIN PROGRAMS, HOWEVER, MAY INCLUDE 
MECHANISMS TO LIMIT OR INHIBIT COPYING, THEY ARE 
MARKED “COPY PROTECTED”), PROVIDED THE COPYRIGHT 
NOTICE MUST BE REPRODUCED AND INCLUDED ON ANY SUCH 
COPY OF THE SOFTWARE OR FIRMWARE; 
AND / OR

2. MERGE IT INTO ANOTHER PROGRAM FOR YOUR USE ON 
THE SINGLE MACHINE (ANY PORTION OF ANY SOFTWARE OR 
FIRMWARE MERGED INTO ANOTHER PROGRAM WILL 
CONTINUE TO BE SUBJECT TO THE TERMS AND CONDITIONS 
OF THIS AGREEMENT).

THE LICENSEE MAY NOT DUPLICATE, MODIFY, REVERSE 
COMPILE OR REVERSE ASSEMBLE ANY SOFTWARE OR 
FIRMWARE IN WHOLE OR PART.

Important Notice
THE SOFTWARE OR FIRMWARE MAY CONTAIN OPEN SOURCE 
SOFTWARE COMPONENTS (“OPEN SOURCE COMPONENTS”). 
OPEN SOURCE COMPONENTS ARE EXCLUDED FROM THE 
TERMS OF THIS AGREEMENT EXCEPT AS EXPRESSLY STATED IN 
THIS AGREEMENT AND ARE COVERED BY THE TERMS OF THEIR 
RESPECTIVE LICENCES WHICH MAY EXCLUDE OR LIMIT ANY 
WARRANTY FROM OR LIABILITY OF THE DEVELOPERS AND/OR 
COPYRIGHT HOLDERS OF THE OPEN SOURCE COMPONENT 
FOR THE PERFORMANCE OF THOSE OPEN SOURCE 
COMPONENTS. YOU AGREE TO BE BOUND BY THE TERMS AND 
CONDITIONS OF EACH SUCH LICENCE. FOR MORE 
INFORMATION SEE:
http://support.taitworld.com/go/opensource

Title to Software 
THIS AGREEMENT DOES NOT CONSTITUTE A CONTRACT OF 
SALE IN RELATION TO THE SOFTWARE OR FIRMWARE SUPPLIED 
TO THE LICENSEE. NOT WITHSTANDING THE LICENSEE MAY 
OWN THE MAGNETIC OR OTHER PHYSICAL MEDIA ON WHICH 
THE SOFTWARE OR FIRMWARE WAS ORIGINALLY SUPPLIED, OR 
HAS SUBSEQUENTLY BEEN RECORDED OR FIXED, IT IS A 
FUNDAMENTAL TERM OF THIS AGREEMENT THAT AT ALL 
TIMES TITLE AND OWNERSHIP OF THE SOFTWARE OR 
FIRMWARE, WHETHER ON THE ORIGINAL MEDIA OR 
OTHERWISE, SHALL REMAIN VESTED IN TAIT OR THIRD 
PARTIES WHO HAVE GRANTED LICENCES TO TAIT.

Term and Termination 
THIS LICENCE SHALL BE EFFECTIVE UNTIL TERMINATED IN 
ACCORDANCE WITH THE PROVISIONS OF THIS AGREEMENT. 
THE LICENSEE MAY TERMINATE THIS LICENCE AT ANY TIME BY 
DESTROYING ALL COPIES OF THE SOFTWARE OR FIRMWARE 
AND ASSOCIATED WRITTEN MATERIALS. THIS LICENCE WILL BE 
TERMINATED AUTOMATICALLY AND WITHOUT NOTICE FROM 
TAIT IN THE EVENT THAT THE LICENSEE FAILS TO COMPLY 
WITH ANY TERM OR CONDITION OF THIS AGREEMENT. THE 
LICENSEE AGREES TO DESTROY ALL COPIES OF THE SOFTWARE 
OR FIRMWARE AND ASSOCIATED WRITTEN MATERIALS IN THE 
EVENT OF SUCH TERMINATION.

Limited Warranty 
THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE 
COMPONENTS) IS SUPPLIED BY TAIT AND ACCEPTED BY THE 
LICENSEE “AS IS” WITHOUT WARRANTY OF ANY KIND EITHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT BEING LIMITED 
TO ANY IMPLIED WARRANTIES AS TO MERCHANTABILITY OR 
FITNESS FOR ANY PARTICULAR PURPOSE. THE LICENSEE 
ACKNOWLEDGES THAT THE SOFTWARE OR FIRMWARE 
(INCLUDING OPEN SOURCE COMPONENTS) IS USED BY IT IN 
BUSINESS AND ACCORDINGLY TO THE MAXIMUM EXTENT 
PERMITTED BY LAW NO TERMS OR WARRANTIES WHICH ARE 
IMPLIED BY LEGISLATION SHALL APPLY TO THIS AGREEMENT. 
TAIT DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED 
IN THE SOFTWARE OR FIRMWARE (INCLUDING OPEN SOURCE 
COMPONENTS) WILL MEET THE LICENSEE’S REQUIREMENTS OR 
THAT THE OPERATION OF THE SOFTWARE OR FIRMWARE 
(INCLUDING OPEN SOURCE COMPONENTS) WILL BE 
UNINTERRUPTED OR ERROR FREE.

Exclusion of Liability
IN NO CIRCUMSTANCES SHALL TAIT BE UNDER ANY LIABILITY 
TO THE LICENSEE, OR ANY OTHER PERSON WHATSOEVER, 
WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT 
(EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT), 
EQUITY, UNDER ANY STATUTE, OR OTHERWISE AT LAW FOR 
ANY LOSSES OR DAMAGES WHETHER GENERAL, SPECIAL, 
EXEMPLARY, PUNITIVE, DIRECT, INDIRECT OR 
CONSEQUENTIAL ARISING OUT OF OR IN CONNECTION WITH 
ANY USE OR INABILITY OF USING THE SOFTWARE OR 
FIRMWARE (INCLUDING OPEN SOURCE COMPONENTS).

THE LICENSEE’S SOLE REMEDY AGAINST TAIT WILL BE LIMITED 
TO BREACH OF CONTRACT AND TAIT’S SOLE AND TOTAL 
LIABILITY FOR ANY SUCH CLAIM SHALL BE LIMITED AT THE 
OPTION OF TAIT TO THE REPAIR OR REPLACEMENT OF THE 
SOFTWARE OR FIRMWARE OR THE REFUND OF THE PURCHASE 
PRICE OF THE SOFTWARE OR FIRMWARE.

General
THE LICENSEE CONFIRMS THAT IT SHALL COMPLY WITH THE 
PROVISIONS OF LAW IN RELATION TO THE SOFTWARE 
OR FIRMWARE.

Law and Jurisdiction 
THIS AGREEMENT SHALL BE SUBJECT TO AND CONSTRUED IN 
ACCORDANCE WITH NEW ZEALAND LAW AND DISPUTES 
BETWEEN THE PARTIES CONCERNING THE PROVISIONS 
HEREOF SHALL BE DETERMINED BY THE NEW ZEALAND 
COURTS OF LAW. PROVIDED HOWEVER TAIT MAY AT ITS 
ELECTION BRING PROCEEDINGS FOR BREACH OF THE TERMS 
HEREOF OR FOR THE ENFORCEMENT OF ANY JUDGEMENT IN 
RELATION TO A BREACH OF THE TERMS HEREOF IN ANY 
JURISDICTION TAIT CONSIDERS FIT FOR THE PURPOSE OF 
ENSURING COMPLIANCE WITH THE TERMS HEREOF OR 
OBTAINING RELIEF FOR BREACH OF THE TERMS HEREOF.

No Dealings 
THE LICENSEE MAY NOT SUBLICENSE, ASSIGN OR TRANSFER 
THE LICENCE OR THE PROGRAM EXCEPT AS EXPRESSLY 
PROVIDED IN THIS AGREEMENT. ANY ATTEMPT OTHERWISE TO 
SUBLICENSE, ASSIGN OR TRANSFER ANY OF THE RIGHTS, 
DUTIES OR OBLIGATIONS HEREUNDER IS VOID.

No Other Terms 
THE LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS 
AGREEMENT, UNDERSTANDS IT AND AGREES TO BE BOUND BY 
ITS TERMS AND CONDITIONS. THE LICENSEE FURTHER AGREES 
THAT SUBJECT ONLY TO ANY EXPRESS WRITTEN TERMS OF 
AGREEMENT TO THE CONTRARY BETWEEN TAIT AND THE 
LICENSEE THIS IS THE COMPLETE AND EXCLUSIVE STATEMENT 
OF THE AGREEMENT BETWEEN IT AND TAIT IN RELATION TO 
THE SOFTWARE OR FIRMWARE WHICH SUPERSEDES ANY 
PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN AND 
ANY OTHER COMMUNICATIONS BETWEEN THE LICENSEE AND 
TAIT RELATING TO THE SOFTWARE OR FIRMWARE.
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